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1)Rational of the work:
· We need the solution of choice when a controller is needed to close the loop.  The reason PID controllers are so popular is that using PID gives the designer a larger number of options and those options mean that there are more possibilities for changing the dynamics of the system in a way that helps the designer.  If the designer works it right s/he can get the advantages of several effects.  In particular, starting with a proportional controller, and adding integral and derivative terms to the control the designer can take advantage of the following effects.
· An integral controller gives zero SSE for a step input.
· A derivative control terms often produces faster response.

· And we need monitoring and controlling of process variables because control loop monitoring and optimization is all about savings—saving energy, raw materials, and operator effort while improving quality and profitability in a plant that depends on feedback controllers to produce a product. Hence the need for a control loop monitor that can provide “a systematic approach to improving control by monitoring control performance, identifying and diagnosing problem loops, recommending tuning and maintenance improvements, and continuously adapting to changing conditions to optimize plant performance. And the problems faced by Control Engineers of C&I departments is that they need to sit continuously for long hours inside Control. So there is need to make control and monitoring of process variable in more efficient, effective and comfortable way: - The solution strike is integration of IIoT(Industrial Internet of things) with control system so that control engineers can monitor and control the process variable comfortably from any location on their web or smart phone application user interface
2) Review of Literature:
	
	
	

	Paper Name/Website
	Author/Organization
	Description

	http://www.controleng.com/
Control Engineering Editorial Research Studies
	Control Engineering
	Control Engineering (CE) conducts research studies on the industries and topics covered by the publication—system integration, machine control, process control, information control, sustainable engineering, manufacturing IT, and safety and security.

	STUDY OF TUNING OF PID CONTROLLER BY USING
PARTICLE SWARM OPTIMIZATION
	Ankita Nayak,
 Mahesh Singh
	Explanation of tuning of Proportional gain, integral gain and derivative gain in efficient way to increase the stability and
performance of the system.

	DEVELOPMENT OF THE PID CONTROLLER
	Stuart Bennett
	Explains different control actions, gives historical and scientific background of automation




3) Objectives:
· To develop PID Controller on ARM Cortex-M4 Processor to control the temperature.

· To design Web Service in order to integrate IIoT(Industrial Internet of things) for controlling and monitoring purpose.

· Developing Learning material of PID concepts in easy and effective way.



4) Methodology:
· Developing the core understanding of Control System, Laplace     Transformation, Embedded system.

· Study of ARM processors and its architecture.


· Choosing the ARM Cortex-M4 controllers and ARM libraries.

· Development of PID controller.


· Tuning of PID parameters.

· Detailed Study of IoT and its application.


· Study of IoT protocols, HTML, CSS, PHP, JavaScript Object Notation, Web-client and web server.

· Designing of Web-services




5) Results of the work completed:Set point

[image: ]					 										  This sensor gives the expected temper-ature which is to be maintained by the process
Process variable (PV), is then transmitted to the PID controller, which compares it to the set point and calculates the Difference, or Error (E), between the two signals. Based on the error and the controller’s tuning constants, the controller calculates the appropriate controller output (PWM signal accordingly to base of transistor for controlling the speed of DC Fan) to keep the temperature at the set point.
This sensor gives the actual temperature (Process Variable) of the location where temperature is needed to be controlled
Process variable
Actuator 

Website url: http://PidiOt.esy.Es/Home.html
[image: ]
This is the home page of the website.
Web services provided are: Monitoring and Controlling of process variable remotely and we also provide learning on PID concepts.







Control and Monitoring

[image: ]Data export of stored data on various formats for detailed analysis



In “Monitor & Control” menu of the webpage we log the data and plot the values graphically.

In our case we developed PID temperature controller.  
2nd graph represents: Expected Value or Setpoint or Reference Value of our control system.
3rd graph represents: Actual value of temperature or value of controlled variable.
1st graph represents: Error between Set point and Controlled variable, and on the basis of error introduced in control system our controller takes PID action and reduces the error. 
We can also export the data logged or stored on the web for further detailed analysis of data on various format like CSV, XML and JSON.



[image: ]Control action command can be sent to PID controller (enabled IoT platform) for controlling purpose remotely.


And also we can send Control action command to the PID controller (enabled IoT platform) for controlling it remotely.

Learn PID
[image: ]

On Clicking on Button “Experimental Tuning of Parameters” given on page “Learn PID”, we can learn how we perform experimental based tuning of PID parameters: Kp: Proportional Gain; Ki: Integral Gain; Kd: Derivative Gain.
Feel PID Action
We will take different values of Kp, Ki, Kd and analyze the controlled variable
Kp: Proportional gain
Ki: Integral gain
Kd: Derivative gain
Role of Kp: Proportional gain, it proportionally accelerates to close the gap between expected value and actual.
Case I: Kp=50, Ki=0.625, kd=100
[image: Capture1]
Since, the value of Kp is low that’s why in this scenario duty cycle which is our controlled variable is low, therefore rise time to minimize our error is large.
Let’s, Increase the value of Kp in order to reduce the error in short period of time.


Case II: Kp=350, Ki=0.625, kd=100
[image: Capture2]
If we compare these results from case I, it is clearly reflecting that the error is getting reduced quickly then the case I.
In case I, where kp=50 at error=0.188 then duty cycle was=11.88%
and in case II, Where Kp=350 at error=0.188 then duty cycle is 73.71%.
The increase in duty cycle (Controlled variable) clearly shows that large value of controlled output to be generated in order to reduce the error in short span of time.
Now, further to reduce rise time and the value of Kp to 550




Case III: Kp=550, Ki=0.625, kd=100
[image: ]
We can see that error is getting reduced more quickly than the case I and Case II


Role of Ki: The integral helps you regain the expected value or to your set point again and maintain it a lot more accurately. It helps in maintaining it a lot smoother than just proportionally accelerating and decelerating.



Case IV: Kp=550, Ki=10.625, kd=100
[image: fin550,10.625,100]
So we increase the value of Ki and observes that rise time is decreased and steady state error also gets eliminated.
Role of Kd: The derivative is used to eliminate an accumulated error on the integral. In our example this would be you noticing actual value growing ever so slightly and preventing the gap from getting any bigger.
PID Tuning Lab-Practical on software
[image: ]
Here, we can learn how to tune PID parameter to obtain better output signal.

This is available for the download on our
website:  http://pidiot.esy.es/Parameter1.html
Then go on Download Experimental_Tuning
6) Future work:
· The proposed method may also be implemented using Field Programmable Gate Array (FPGA)

· The concept of this work may be applied for Optimum design of controllers using Firefly Algorithm

· The proposed procedure may also be implemented using Bees Algorithm for Optimum Controller design 

· The proposed scheme may be applied for Optimum Controller design using Bat Algorithm

· This concepts can be extended for the design of feedback controller for MIMO systems


· This Procedure may be applied for practical applications in industry oriented Problems
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Internet of Things
Rationale of the Work Done:
In the emerging global world, as the advances in technology has taken fast pace, the lifestyle of people has also been drastically changed. IOT is referred to as inter connection of sensors and computing devices with the internet infrastructure. A general concept of Internet of Things revolves around collecting data from sensors, store and process it for various purpose. The IoT allows objects to be sensed and controlled remotely across existing network infrastructure, creating opportunities for more direct integration of the physical world into computer-based systems, and resulting in improved efficiency, accuracy and economic benefit. The expansion of Internet-connected automation into a plethora of new application areas, IoT is also expected to generate large amounts of data from diverse locations, with the consequent necessity for quick aggregation of the data, and an increase in the need to index, store, and process such data more effectively. IoT is one of the platforms of today's Smart City, and Smart Energy Management Systems. One such application of IOT is Home Automation. IoT devices can be used to monitor and control the mechanical, electrical and electronic systems used in various types of buildings (e.g., public and private, industrial, institutions, or residential) in home automation and building automation systems. Home automation is the residential extension of building automation and involves the control and automation of lighting, heating, ventilation, air conditioning (HVAC), appliances, and security. Modern systems generally consist of switches and sensors connected to a central hub sometimes called a "gateway" from which the system is controlled with a user interface that is interacted either with a wall-mounted terminal, mobile phone software, tablet computer or a web interface. A basic home automation solves many simple problems effectively, from saving energy easily, to removing the possibility of being locked out by losing a physical key, from checking if you had locked your door or turned that appliance off after you actually leave, to informing you about the foot traffic on your porch when you're not home. We have made some modules which include controlling of a light source remotely from web service, measuring the room temperature and sending the data to the cloud to further run analysis and take alert actions. 




Literature Survey:
When people think about home automation, most of them may imagine living in a smart home: One remote controller for every household appliance, cooking the rice automatically, starting air conditioner automatically, heating water for bath automatically and shading the window automatically when night coming. To some extent home automation equals to smart home. They both bring out smart living condition and make our life more convenient and fast. People at that time understood that a smart home is not owing to how well it is built, not how effectively it uses space, not due to how it is environmentally friendly. It is only because of how interactive technologies that it contains. Those are still useful rules for home automation technology today. Home automation technology and Smart home appeared very much in science fiction of the 1920s. But no one knows the exact date of the invention of home automation.
Based on human’s smart technology improving process, the home automation
system does not come by immediate invention. It comes step by step with only insignificant improvement. The previous step is almost same with the next step. Manufactures of labour saving appliances have been promising homeowners an automated “Home of the Future” since the World’s Fair days of the 1930s. The intelligent home has been a popular vision for a few decades. The first time people noticed the high technology in dwelling, they did some connection with home automation, and it was 1960s. Experts considered that by the end of the century people would live in smart homes that contained independent household machined. Although many of the machines in these visions are today technically possible to manufacture of course, the present situation is not exactly the same as what the expert’s decades ago
 
In the 1960s, there were not so much interactive technologies. Even though
Stanford University researched a lot of this kind of technology, they didn’t become so successful. They concluded some principal reason for not succeeding is scientific research. Some of the factors are due to the lack of motivation to increase productivity in domestic work. They considered the less involvement of users of the technology in the design process. They also concluded the view held by product designers that domestic technology is unexciting and the continued focus on stand-alone appliances in the design of new technology.
Home automation satisfies the resident’s needs and desires by adjustable light,
temperature, ambient music, automatic shading, safety & security, even arrangement of wire. Home automation technologies are the latest fascination with housing mechanism. However, with the appearance of new electronic technologies and their combination with older, traditional building technologies, the smart home is at last becoming a reality. In 1975 a company called Pico Electronics developed and patented the X10 Power Line carrier technology. The company had already tried nine different approaches with no success, but while developing the system for tenth time they finally manage to succeed, so they decided to call the technology X10. The idea behind X10 was to transmit a 120 kHz signal on the electrical power line. Every signal was specifically coded with a House and Unit code. Although such technologies had been developed for the part of 50 years none of them was implemented in any similar fashion. After the patented their work it took just a few years for introducing their firs product into the market. So in 1978 they release the X10protocol to the market. Due to the fact that data transmission was done reusing powerlines, it was relatively cheap because no additional writing was needed. The basic idea of home automation is to monitor a dwelling place by using sensors and control systems. Through adjustable various mechanisms, user can enjoy customized heat, ventilation, lighting, and other servers in living condition. The more closely adjust the entire living mechanical system and loop control system, the intelligent home can provide a safer, more comfortable, and more energy economical living condition.
 The current major initiatives in Japan, the US and Europe to develop more comprehensive systems originated in the 1980s. In Japan,
the term “Home Automation” was first coined among the Japanese companies who showed the earliest interest in the concept of a complete home control system. The earliest home control systems were proposed by Hitachi and Matsushita in 1978. In 1980, Yoneji Masuda, one of the early pioneers of computerization in Japan, wrote the book “The Information Society As Post 
-Industrial Society in which he discussed changes in society , information and knowledge industries, analyzed the technology that would free people to live more creative and happy lives: computer- controlled vehicle systems, automated supermarkets, etc. From the early 1980s, many Japanese firms published their own home automation blueprints, developed demonstration houses and launched proprietary systems. These included major electrical appliance manufacturers such as Matsushita, Toshiba, Mitsubishi, Sanyo, Sony, and Sharp. Some interphone companies first added security functions to their systems. Secom, a security services firm, expanded upon its original security system to develop a central control station for remote control of home security. The TRON project, which was started in 1984, encompassed more than the other home automation packages currently under development, being especially concerned with architecture and the experience of space inside the house. In September 1988,
the “Home Bus System” industry standard was issued. In US, 1982,
AT &T established the concept of “Intelligent Building”. The Informant
Building an office building and conference center in Dallas which promoted a good sense of community among tenants and customers, was erected to demonstrate how advanced IT from different suppliers could be used in the intelligent building. The Smart House Project was established in 1984 as project of the National Research Center of the National Association of Home Builders (NAHB), USA, with the cooperation of a number of major industrial partners. NAHB formed the SMART HOUSE Limited Partnership (L.P.). It sought the participation of several manufactures for every major type of hardware that would be needed for Smart House systems. 

Objectives: 
The objective of this project is to implement a low cost, reliable and scalable home automation system that can be used to remotely switch on or off any household appliance, using a microcontroller to achieve hardware simplicity. We build a base framework for an automation system that can be centrally controlled using any device running the web service. We chose to show a lighting control system and temperature as proof of concept. We can also monitor all the data on a dedicated cloud and take trigger actions accordingly. The framework makes it easier to integrate other such end applications.

Methodology:
Sensors are the eyes of a home automation system. They “see” the environment and convert what they find into an electrical quantity that can be measured by a microcontroller or system processor. Basic home automation sensors include temperature sensors, humidity sensors, light sensors. Data in the form of signals from these sensors can be used to control the various appliances directly without any human intervention. For example, lights can be automatically switched on upon rise in temperature, the temperature can remotely be monitored and take actions accordingly. 
[image: ]
Sensors then send the data to the serial monitor where the temperature is measured.  Temperature sensor hooked up to your Arduino and you want to see the value that the temperature sensor is recording, we use the Serial.print() function to send the data to a computer monitor via the USB cable. If we open up the serial monitor window (Tools > Serial Monitor), you will see the values streaming in from the Arduino.
[image: Image of serial monitor widow using Serial.print() with Arduino to send bits one at a time]
The other big reason to send information to a computer display using the Serial.print() function is for developing and debugging Arduino sketches.
[image: Serial.print() with Arduino send bits one at a time]
The serial library allows us to interface the Arduino with other hardware, like a computer. 
[image: ]
Instead of Arduino, we use NodeMCU integrated in Arduino IDE. NodeMCU is an open source IoT platform.[4][5] It includes firmware which runs on the ESP8266 Wi-Fi SoC from Espressif, and hardware[6] which is based on the ESP-12 module. The term "NodeMCU" by default refers to the firmware rather than the dev kits. The firmware uses the Lua scripting language. It is based on the eLua project, and built on the Espressif Non-OS SDK for ESP8266.
But we can even use Arduino IDE to interface with NodeMCU as it is compitable board with Arduino.
[image: ]

[image: ]
· It is assumed that the Access Point is able to access to internet, and a ThingSpeak account is set up accordingly.
· Connect 5v and Gnd and from NodeMCU v1.0 to DHT11 respectively.
· Connect data from DHT11 to pin4 on NodeMCU v1.0 (in code, it will be used as pin2)
· Connect microUSB to NodeMCU v1.0.
· Launch ESP8266 Arduino IDE, Select Tools -> Board -> NodeMCU v1.0; and ensure parameters are correct. Refer to screenshot.
· Ensure the libraries required are installed, Select Sketch -> Include Libraries -> Manage Libraries or add zip library
· Program the source code to read DHT11 using one wire protocol and the acquired data to be sent to thingspeak.

The data sent to Thingspeak Cloud is monitored.
[image: ]
[image: ]
[image: ]
Once the data is sent to the cloud, it is further configured to take a trigger action. When the temperature rises above a predefined threshold, we led is initiated to blink and also an e-mail is sent to alert the user about the temperature rise.
The alert is configured through IFTTT and Maker. The alert is triggered to send an e-mail.
[image: https://forge3.com/wp-content/uploads/2014/05/Save-time-using-the-web-with-these-24-IFTTT-recipes.jpg]
[image: http://cdn.makeuseof.com/wp-content/uploads/2015/08/ifttt-confirm.png?b34c28]
And Finally triggered a mail:
[image: ]
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FINAL WORKING:
[image: ]

We have used Wi-Fi mode to communication to achieve internetworking.
[image: http://static.diffen.com/uploadz/f/f2/Wifi-1.jpg]
Wi-Fi is a technology that allows electronic devices   to connect to a wireless LAN (WLAN) network, mainly using the 2.4 gigahertz (12 cm) UHF and 5 gigahertz (6 cm) SHF ISM radio bands. 
[image: https://www.openhomeautomation.net/wp-content/uploads/2013/09/featured-1210x423.jpg]


RESULTS OF THE WORK:
We successfully connected various sensors to NodeMCU and Monitored the data on Serial Monitor and Thingspeak. We also initiated a trigger action if the temperature rises above a particular threshold. This is initiated from the cloud.

Future Work with clear milestones:
We are further planning to extend this project to a test bed scenario where we can monitor temperature of a particular room and have monitoring parameter devices in a remote monitoring room.  We will remotely control devices from the monitoring room using Applications. Monitoring Security will also be an important addition to the project.
We are also going to test the cases in various communication modules and communication protocols to examine the fastest and efficient way of transferring data.
[bookmark: _GoBack]
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